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Chapter 1: Introduction

Artist Control, Artist Mix, Artist Transport, and Artist Color comprise the Artist Series family of media controllers. They use a 
100 Mb/s Ethernet EUCON™ connection to control audio and video applications running on a workstation computer. EUCON is 
a high-speed communication protocol and enables control of virtually every application feature. 

Each Artist Series media controller can run as a standalone device. Up to four Artist Mix units can be used with one Artist Control 
and/or one Artist Transport to create a larger control surface. Artist Series media controllers borrow many features from the 
MC Pro and System 5-MC.

Artist Control supports two types of applications:
• EUCON-aware applications (such as Pro Tools® 9.0 and higher, Media Composer®, Cubase, Logic Pro, and Nuendo) directly 

support the EUCON protocol. They provide the highest level of integration, high-resolution controls, and high-speed con-
nectivity.

• Non-EUCON-aware applications that support Mackie Control or HUI (such as Pro Tools 8.x and lower, Live, and Reason) 
can use many functions but are less integrated than EUCON-aware applications. 

Artist Control can also provide some functionality over non-EUCON-aware applications that do not support HUI or Mackie Con-
trol by sending out keystroke commands over EUCON. 

EuControl Software
The EuControl software application is responsible for finding, linking, and communicating with all Artist Series controllers on the 
network. EuControl must be installed on the computer that runs the applications you want to control before using Artist Series con-
trollers. 

What’s Included
• Artist Control, with riser brackets

• EuControl software installer disc

• 1 Ethernet Crossover cable

• Power supply

• Artist Control Quick Setup 

• Registration Information Card
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System Requirements and Compatibility
Avid can only assure compatibility and provide support for hardware and software it has tested and approved. 

For compatibility, downloads, and Artist Series support, visit: 
www.avid.com/artistsupport

Registration
Review the enclosed Registration Information Card and follow the instructions on it to quickly register your purchase online. 
By registering, you become eligible to receive the following:

• Technical support information

• Software update and upgrade notices

• Hardware warranty information

About This Guide

Conventions Used in This Guide
All of our guides use the following conventions to indicate menu choices and key commands:
:

The names of Commands, Options, and Settings that appear on-screen are in a different font. The names of keys on Artist Series 
hardware are in bold (such as SEL). The SHIFT key on Artist Series hardware is indicated by bold text, in all-caps (SHIFT) to dis-
tinguish it from references to the Shift key on your computer keyboard. 

The following symbols are used to highlight important information:

Convention Action

File > Save Choose Save from the File menu

Control+N Hold down the Control key and press the N key

Control-click Hold down the Control key and click the mouse button

Right-click Click with the right mouse button

User Tips are helpful hints for getting the most from your system.

Important Notices include information that could affect your data or the performance of your system.

Shortcuts show you useful keyboard or mouse shortcuts.

Cross References point to related sections in this guide and other Avid guides.
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About www.avid.com
The Avid website (www.avid.com) is your best online source for information to help you get the most out of your system. 
The following are just a few of the services and features available. 

Product Registration Register your purchase online. 

Support and Downloads Contact Avid Customer Success (technical support); download software updates and the latest online 
manuals; browse the Compatibility documents for system requirements; search the online Knowledge Base or join the worldwide 
Avid community on the User Conference. 

Training and Education Study on your own using courses available online or find out how you can learn in a classroom setting at 
a certified Avid training center. 

Products and Developers Learn about Avid products; download demo software or learn about our Development Partners and their 
plug-ins, applications, and hardware. 

News and Events Get the latest news from Avid or sign up for a demo.
Chapter 1: Introduction 3
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Chapter 2: Installation and Setup

Unpacking and Elevating the Artist Control
Unpack Artist Control, its power adapter, AC power cord, Installer disc, Ethernet crossover cable, and riser brackets. 

Artist Control can be elevated or angled using small foldout legs on the bottom of the unit or elevated and angled by attaching the 
larger riser brackets. Since either method requires turning Artist Control over, it is easier to do this before attaching any cables. 
Turn it over and place it on a soft surface.

Pull out all four of the small foldout legs to moderately elevate the unit; pull out only the back two to angle the unit towards you. 
Pull out the metal clips from the same area as the legs and move them until they snap into the legs.

Two larger, detached riser brackets elevate and angle the unit more than the foldout legs. Use moderate force to snap them into the 
bottom panel as shown.

To remove the riser brackets:

1 Use a #2 Phillips screwdriver to remove the two silver screws that secure the side panel to the unit. 

Removing screws from the bottom panel (riser brackets not shown)
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2 Lift the black plastic connecting part and side panel up and out of Artist Control.

3 Press the tabs to release the riser bracket and lift it out of the side panel.

4 Repeat these steps for the riser bracket on the other end of the unit. 

5 Reattach the side panels to the unit and replace the #2 Phillips screws to secure them. 

Attaching an Artist Control to Additional Units
An Artist Control can be physically attached to up to four Artist Mixes and one Artist Transport to form a larger, stable control 
surface. 

To join an Artist Control to an Artist Mix:

1 On the Artist Control, use a #2 Phillips screwdriver to remove the two silver screws. The screws may be tight, so you may have 
to use some force.

2 Lift the black plastic connecting part and side panel up and out of Artist Control.

Removing the side panel (riser brackets not shown)

Tabs to release the riser bracket from the side panel

Removing screws from the bottom panel

Removing connecting part and side panel from Artist Control
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3 On the Artist Mix, remove the side panel on the end where it will attach to Artist Control (slide the side panel towards the front 
of the unit, then pull it away).

4 Slide the connecting part of Artist Control into Artist Mix to attach them together.

Installing Software and Hardware
You must install EuControl software before using your Artist Series media controller. 

To install EuControl software and your Artist Series media controller: 

1 Do one of the following:

• Download the EuControl installer for your computer platform from www.avid.com/artistsupport. After downloading, make sure 
the installer is mounted or uncompressed (.dmg on Mac or .ZIP on Windows).

• Insert the Installer disc into your computer. 

2 Double-click the EuControl installer application.

3 Follow the on-screen instructions to complete the installation. 

4 When installation is complete, click Quit (Mac) or Finish (Windows). EuControl will launch automatically and is running when 
its icon appears: 

• On Mac, the icon is shown in the menu bar. 

• On Windows, the icon appears in the System tray (or alongside other Hidden Icons in the lower tool bar if you do not have your 
system configured to always show icons in the System tray). 

5 Shut down your computer. 

Removing side panel from Artist Mix

Artist Mix and Artist Control attached by connecting at side panel

If prompted to download the most current version of EuControl, follow the onscreen instructions. 

EuControl icon
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6 Plug one end of the AC power cord into the power adapter and the other into a power outlet. Make sure the AC power cord is 
pushed all the way into the adapter.

7 Connect the DC output cable from the power adapter to DC In on the left side of the rear panel. 

8 Plug one end of the Ethernet crossover cable into the Ethernet jack (labeled with) on the rear panel of the Artist Control.

Connecting the power adapter

Connecting the power adapter

Ethernet cable and rear panel jack

DC  In  15  V

FOOTSWITCH

Eucon
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9 Plug the other end of the Ethernet crossover cable into an open Ethernet jack on your computer, router, or Ethernet switch. Note 
that connecting directly to the computer may require removing your Internet cable. 

If you have a Mac with two Ethernet ports, it is recommended to use Ethernet 1 rather than Ethernet 2. However, if you want to use 
Ethernet 2 do the following: 

• Go to System Preferences > EUCON. 

• Change the Network Interface to Ethernet 2. 

• Restart the computer.

An Ethernet router or switch is required to connect multiple Artist Series units such as an Artist Control with one or more Artist 
Mix controllers, or to connect units to a local area network. 

10 Turn on your router (if applicable), then turn on your computer and wait until it finishes starting up.

11 Press and release the POWER switch on Artist Control. Do the following, as appropriate for your operating system: 

Mac Wait up to 60 seconds. A lit EuControl icon in the menu bar indicates correct installation. 

Artist Control connected directly to computer

Artist Control and one Artist Mix connected using a router 

EuControl icon on Mac

SOLOSOLO ON ON SOLOSOLO ON ON SOLOSOLO ON ON SOLOSOLO ON ON
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Windows Wait up to 60 seconds. A lit EuControl icon appears in the System tray (or, in Hidden Icons if your system is not con-
figured to show all icons in the System tray).

12 If the lit EuControl icon does not appear, do any of the following: 

• See “Surfaces” on page 35 and add Artist Control manually.

• Shut down Artist Control and your computer, then turn them on (computer first, then Artist Control).

• If your Mac is pre-2002 and you are using an Ethernet router or switch, you need to purchase a normal straight-through Ethernet 
cable (instead of the included crossover Ethernet cable) from a computer store. 

• See www.avid.com/artistsupport for the most current troubleshooting information.

13 If you downloaded the latest software from the web, you may need to update the firmware on your Artist Series controllers. See 
“Update Firmware” on page 36 for instructions.

14 Launch your application (such as Pro Tools, Logic Pro, Cubase, or Digital Performer) and open a session or project. 

15 To set up your application to work with Artist Control, see the EUCON Application Setup Guide that you downloaded earlier. 

Controlling a Second Workstation

Artist Control can control applications running on a second computer, referred to in this guide as a workstation. If EuControl is run-
ning on the same workstation as all your audio/video applications you can skip these instructions. 

To be able to control a second workstation:

1 Do one of the following:

• Download the EuControl installer from www.avid.com/artistsupport onto the second computer. After downloading, make sure 
the installer is uncompressed (.dmg on Mac or .ZIP on Windows).

• Insert the Installer disc into the second computer. 

2 In the Extras folder, double-click the Install EUCON Workstation installer. 

3 Follow the instructions to install the EUCON software.

EuControl icon on Windows
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Connecting a Footswitch

The Artist Control has a ¼-in FOOTSWITCH input on the rear panel. The footswitch can be used to punch in and out of recording. 
Plug the footswitch in before powering on the Artist Control. See “Footswitch” on page 40 for details. 

FOOTSWITCH input on rear panel

DC  In  15  V

FOOTSWITCH
Chapter 2: Installation and Setup 11
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Chapter 3: Common Tasks

The following Artist Control items and terms are used in common tasks:

• The Soft Knobs can be turned like a conventional knob and pressed like a switch to access an additional context-sensitive func-
tion (some do not have a second function).

• The Soft Knobs access a hierarchical menu system. The beginning of the menu system, called the top-level knob set, lets you 
choose among eight functions to control with the Soft Knobs. 

• The Touchscreen has two rows of six Soft Key labels that correspond to the two rows of physical Soft Keys. Press the 
SOFT KEYS ^ and v page keys to display additional Soft Key assignments and labels. 

• Press and hold the SHIFT key, found at the bottom-left and -right of Artist Control, to access the functions labeled in blue.

1 Soft Knobs

2 Soft Keys page keys

3 Soft Keys

4 Soft Key labels

Soft Knobs, Soft Keys, and Touchscreen

SOFT KEYS

HOME

END

1 1

2
4

3
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Fader Strip
To use the fader strip:

1 Press a fader SEL key on Artist Control. The corresponding track is selected in your application and highlighted on the Touch-
screen. 

2 Move the fader up and down.

You are now controlling the level of your track with Artist Control. The top of the Touchscreen displays a level meter and other 
track information.

3 Press the PAN Soft Knob to access the Pan knob set.

4 Turn the appropriate Soft Knob to adjust the pan of your application’s audio track. Note that this is not the same knob you 
pressed in step 3. 

5 Press the NUDGE> key to move all four tracks over one strip. If tracks 1–4 were assigned to strips 1–4, tracks 2–5 are now as-
signed to strips 1–4.

6 Press and hold the SHIFT key and press the <BANK key to restore tracks 1–4 to strips 1–4. The SHIFT key accesses the functions 
labeled in blue, in this case the HOME function. For convenience, another SHIFT key is located at the bottom-left of Artist Con-
trol.

7 Press the BANK> key to shift tracks over four at a time. If tracks 1–4 were assigned to strips 1–4, tracks 5–8 are now assigned 
to strips 1–4. The <NUDGE and <BANK keys perform similar operations but in the opposite direction.

Inserts
To control inserts:

1 If tracks 1–4 are not assigned to strips 1–4, press and hold the SHIFT key and press the <BANK key to restore tracks 1–4 to strips 
1–4. 

2 Add a plug-in on track 1 of your application.

3 Press a fader SEL key to select the track on which you inserted a plug-in.

4 Press the BACK key until the top-level knob set is displayed on the Touchscreen.

5 Press the INSERTS Soft Knob. The names of the plug-ins on that track are distributed across the Soft Knobs. 

6 Press the Soft Knob beside the desired plug-in name to select it. The plug-in parameters are distributed across the Soft Knobs. 

7 Turn the Soft Knob beside the desired parameter to adjust its value.

8 Press a flashing PAGE key to access more parameters.

9 Press the BACK key to exit that plug-in.

Fader strip SEL (select) switch (left); PAGE, NUDGE, and BANK keys (right)

AUTO
REC N

ASSIGN
SEL Y

12

6

0

5

10

20

30

1

CFG

PAGE

BANK

HOME

NUDGE

MIXER

END

BANK

CLOSE

NUDGE

PAGE

CFG
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Transport Keys and Jog Wheel
To use the Transport keys:

 Use the PLAY, STOP, FF, and REW buttons to navigate the timeline of the edit window of your application.

To use the Job wheel:

1 Press the JOG key.

2 Spin the Jog Wheel clockwise and counterclockwise to move forward and backward, respectively, on the timeline.

JOG
SHUTTLE

ZOOM HORIZ
ZOOM VERT

REC

REW

FF

STOP

PLAY

JOG
SHUTTLE

ZOOM HORIZ
ZOOM VERT

REC

REW

FF

STOP

PLAY
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Chapter 4: Surface Controls

Artist Control has four channel strips each with a touch-sensitive fader, eight touch-sensitive knobs (called the Soft Knobs) sur-
rounding a 7-inch touchscreen, twelve Soft Keys, transport switches, a Jog wheel, and various navigation buttons. Artist Control 
comes with an external DC power supply. Rear panel jacks include DC power input, RJ-45 Ethernet, and ¼-inch footswitch.

1 Fader Strips

2 Soft Knobs rotary encoders

3 Volume (CONTROL ROOM/MONITOR)

4 Navigation switches

5 Power

6 SHIFT

7 Soft Key navigation

8 Soft Keys

9 Transport and Jog Wheel

Surface Controls

1 543

8

2

6
7

96
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Power Switch
Press and release the POWER switch to turn Artist Control on/off. 

Reset
You can reset the surface name and (any) IP Address assigned to the unit by doing the following. 

To reset the Artist Control Surface Name and IP Address: 

1 Make sure the unit is powered off. 

2 Press and hold BACK while pressing the POWER switch. 

Test Mode
You can enable Test mode to check faders and switches (also known as “Vegas mode”), or to calibrate the Touchscreen. 

Test Mode for Faders and Switches

To access Test mode for Faders and Switches: 

1 Make sure the unit is powered off. 

2 Hold <BANK+BANK>+NUDGE>+the left SHIFT key while pressing POWER to power the unit on. The faders begin to travel 
through from lowest to highest positions and back. LEDs flash on/off. While in Test mode, do any of the following: 
• You can press any switch to see its name display on the Touchscreen. 

3 To exit Test mode, power the unit off. 

Touchscreen 

To calibrate the Touchscreen, see “Calibrating the Touchscreen” on page 33. 

Shift Key
The SHIFT key is used in conjunction with other keys to access the functions labeled in blue above the primary function. Press and 
hold the SHIFT key, found at the bottom-left and -right of Artist Control, then press the other key.

Locking the Shift Key
The SHIFT key can be locked to access multiple alternate key functions without holding the SHIFT key down. 

To lock the Shift key:

1 Press and release the SHIFT key quickly and then press another key to access its alternate function. Continue in this manner until 
finished. 

2 Press and release the SHIFT key quickly again to restore normal operation. 

The following terminology is used to describe SHIFT functions.

Example:

• “Press and hold the SHIFT key then press the AUX key” 
is written as

• “Press SHIFT+AUX/GROUP”

If you have another Artist Series controller connected to the same instance of EuControl as Artist Control, you can also lock the 
SHIFT key by pressing two SHIFT keys down simultaneously. They can be on different devices. Unlock the SHIFT key by pressing 
and releasing one quickly on any device. See “My Surfaces” on page 36 for more information.
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Fader Strips
Artist Control provides four fader strips, each with a touch-sensitive fader, to control tracks in an audio or video application.

Fader
The fader controls the track assigned to this strip. It is motorized, so it reflects changes made in the application, such as automation. 
It is also touch sensitive, which some applications use when automating.

When the Select by Touch General preference is enabled, touching a fader selects that track in the application and focuses it, just 
like pressing the SEL key. (See “Preferences” on page 39.) Holding down the SHIFT key and touching a fader sets it to unity gain.

ON
The track is on (unmuted) when the strip On key is lit and off (muted) when the strip On key is not lit.

SOLO
The SOLO key lights red when that strip’s track is soloed and is unlit otherwise.

SEL
Pressing a fader SEL key selects that track in the application and focuses it on Artist Control. The SEL key lights yellow when the 
track is selected and is unlit otherwise. All knob functions operate on the focused track.

ASSIGN 
Press the ASSIGN key to display the Assign tab in the EuControl Settings dialog (see “Assign” on page 40).

REC
Press the REC key to enable recording on a track. The REC key lights red to indicate that track is enabled (armed) for recording. 
Press the REC key to cancel a track enabled for recording. 

AUTO
To change the automation mode on a track, press the AUTO key until the desired automation mode displays on the Touchscreen.

Fader strip

Some applications allow selecting multiple tracks if the Shift key on the QWERTY keyboard is held down while selecting tracks. In this
case, the attentioned track is the one whose SEL key was most recently pressed.

Some applications blink the REC LED when armed but not recording and light solid when recording.

E

AUTO
REC N

ASSIGN
SEL Y

12

60

40

6

0

5

10

20

30

8

SOLO ON
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Navigation Controls
Scroll through tracks using the BANK and NUDGE keys. HOME and END are shortcuts to the first and last banks, respectively.

BANK and NUDGE
The BANK and NUDGE keys change which tracks are assigned to the strips. The four strips can be thought of as a window that 
moves in the direction indicated by the arrow over the tracks in the application. 

<NUDGE

Moves the window one track to the left. If strips 1–4 had tracks 5–8, they now have tracks 4–7.

NUDGE>

Moves the window one track to the right. If strips 1–4 had tracks 5–8, they now have tracks 6–9.

<BANK 

Moves the window one bank (four tracks) to the left. If strips 1–4 had the bank starting at track 5, they now have the bank starting 
with track 1. Pressing <BANK again does nothing because the first bank is already shown.

BANK>

Moves the window one bank (four tracks) to the right. If strips 1–4 had the bank starting at track 5, they now have the bank starting 
with track 9. 

MIXER and CLOSE

Not all applications support these keys.

MIXER

Opens and closes the application’s mixer window. The MIXER key is available by pressing SHIFT + <NUDGE/MIXER. 

CLOSE

Closes any open window or dialog box on the application. The CLOSE key is available by pressing SHIFT + NUDGE>/CLOSE.

Fader navigation controls

CFG

PAGE

BANK

HOME

NUDGE

MIXER

END

BANK

CLOSE

NUDGE

WORKSTATION
APPLICATION

TOP
BACK

PAGE

CFG

1 2 3 4 5 6 7 8 9 10 11 141312 15 16Tracks

Strips

Window
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HOME and END

HOME

Moves to the first bank with tracks 1–4 assigned to strips 1–4. (Press SHIFT + <BANK/HOME.)

END

Moves to the last bank. (Press SHIFT + BANK>/END.)

APPLICATION
Press the APPLICATION key to toggle between the two most recently used open applications. Hold down the APPLICATION key 
and press BANK> to toggle between all open applications in a circle. Hold down the APPLICATION key and press <BANK to cycle 
through applications in the opposite direction.

WORKSTATION
Artist Control can control applications running on a second computer, referred to in this guide as a workstation. Press the 
WORKSTATION key (SHIFT + APPLICATION/WORKSTATION) to attach Artist Control to another workstation. You must first 
use EuControl to create a list of workstations that this key switches between (see “Workstations” on page 37). 

While attached to a second workstation, your computer keyboard and mouse can be configured to control that workstation 
(see “Workstations” on page 37).

Navigating Among Multiple Artist Media Controllers
The BANK and NUDGE keys perform the identical actions on the combined set of tracks.

Knobs
Eight touch-sensitive knobs (Soft Knobs) surround the Touchscreen. Each is a continuously rotating knob that adjusts parameters 
such as pan and aux send levels. Each Soft Knob has a built-in switch allowing it to be pressed from the top. This is called the Knob 
Top key and is typically used to access sub-menus but also to turn parameters on and off. 

Knob Set Selection
A knob set is an array of knobs used by EUCON-aware applications to control plug-ins, EQs, dynamics, aux sends, and other func-
tions. When Artist Control first starts, the Top Level Knob Set is displayed on the Touchscreen, showing all eight knob sets beside 
the eight knobs. Press a Knob Top to select that knob set and enter the Artist Control menu system. 

Some knob sets can display another knob set called a sub-menu. For example, the Inserts knob set shows the names of every plug-in 
inserted on the track, one plug-in name per knob. Pressing a plug-in’s Knob Top key displays the parameters of that plug-in on the 
knobs for editing. This new knob set is a sub-menu of the Inserts knob set. Press the BACK key to return to the top of the Inserts 
knob set. Since sub-menus can be more than one level deep, this can be accomplished by pressing the BACK key repeatedly.

INSERTS

Pressing the INSERTS key displays the inserts knob set for editing plug-ins. The first plug-in is displayed on the knob. Pressing one 
of these Knob Tops displays the first eight plug-in parameters for editing. Pressing a Knob Top displays the plug-in parameters for 
editing. 

EQ

Press the EQ key to display the EQ knob set to configure equalization controls and filters. This shows four EQ bands on eight 
knobs. 
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AUX

Press the AUX key to display the Aux (Sends) knob set to control auxiliary sends. The first aux send is displayed. Up to eight aux 
sends can be shown at once.

PAN

Press the PAN key to display the Pan knob set to configure stereo or surround panning. The stereo pan control is typically displayed. 
The first page of eight pan knobs is shown.

INPUT

Press the INPUT key to display the Input knob set to configure input routing, mic gains, phantom power, and other application-spe-
cific parameters. 

DYN

Press the DYN key to display the Dynamics knob set to configure compressors, limiters, expanders, and gates.

GROUP

Press the GROUP key (SHIFT + AUX/GROUP) to display the Group knob set to configure group bus routing or control group 
(VCA) membership.

MIX

Press the MIX key to display the Mix knob set to configure output routing.

Knob Functions
Each knob has the following controls:

• Touching the knob’s image on the Touchscreen toggles the state of its primary parameter, such as EQ Band 1 on or off. When on, 
a small green LED lights on the lower left.

• Pressing the SHIFT key and touching the knob’s image on the Touchscreen toggles its secondary parameter (if it exists), such as 
toggling an aux send between pre- and post-fader. This can also change the knob function between two or more parameters, such 
as EQ Frequency and Q. When active, a small yellow LED lights on the upper left.

Knob Set Navigation Keys
Since a knob set may have more parameters than knobs, the < PAGE > keys scroll among them.

<PAGE 

Press the <PAGE key to scroll to the previous page. When on the first page, pressing <PAGE does nothing. The <PAGE key lights 
yellow when there is a previous page to go to. 

PAGE>

Press the PAGE> key to scroll to the next page. When on the last page, pressing PAGE> does nothing. The PAGE> key lights yel-
low when there is a next page to go to. 

Knob Set navigation keys

CFG

PAGE

WORKSTATION
APPLICATION

TOP
BACK

PAGE

CFG
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Configuration Pages (CFG)

Many knob sets have a configuration page to set up that knob set. The configuration page for the Inserts knob set, for example, is 
used to assign plug-ins to a track. The configuration page for the Aux knob set assigns aux sends to a track. Some applications use 
the configuration page to recall plug-ins and EQs.

Press the <PAGE and PAGE> keys simultaneously to display a knob set’s configuration page, if it has one. When on the configu-
ration page, both the <PAGE> keys light. 

BACK

Press the BACK key once to return to the previous knob set. Press the BACK key repeatedly to back out of all sub-menus and dis-
play the top level knob set. 

TOP

Press the TOP key to immediately back out of all sub-menus and display the top level knob set. This is equivalent to pressing the 
BACK key repeatedly.

Soft Keys
Artist Control supports Surface Soft Keys (introduced in this section) and Touchscreen Soft Keys (see “Soft Keys” on page 29). 
This is one of the most powerful features of Artist Control (see Chapter 7, “Soft Keys”). 

Below the Touchscreen are 12 Soft Keys (six per row). The bottom of the Touchscreen contains labels for each Soft Key. Soft Key 
labels contain text plus an optional icon. 

Soft Keys are organized into pages with 12 Soft Keys per page. The page numbering starts with one and there is no limit to the num-
ber of pages. A Soft Key can be programmed to jump to an arbitrary Soft Key page, allowing creation of menus and webs of Soft 
Key pages. The following keys navigate through Soft Key pages:

SOFT KEYS ^ Go to the previous soft key page, if there is one.

SOFT KEYS v Go to the next soft key page, if there is one.

HOME Go to Soft Key page 1. (Press SHIFT + SOFT KEYS^.)

END Go to the last Soft Key page. (Press SHIFT + SOFT KEYS v.)

Soft Keys

SOFT  KEYS

HOME

END
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Jog Wheel and Transport Controls
The Jog Wheel controls jog, shuttle, zooming, and other functions. Surrounding it are keys that control Jog Wheel functions and 
transport keys. 

Many EUCON applications control far more functions with the Jog Wheel, such as trimming clip head and tail, setting clip gain, 
making crossfades, and similar functions. These functions are accessed using Soft Keys.

Jog Wheel Functions
JOG  Press the JOG key and spin the Jog Wheel clockwise and counterclockwise to move forward and backward, respectively, on 
the timeline. The yellow LED lights in this mode. 

SHUTTLE Press the SHUTTLE key (SHIFT+JOG) and spin the Jog Wheel clockwise and counterclockwise to adjust the forward 
and backward playback speed, respectively.The playback speed is proportional to the wheel’s position. The yellow LED lights in 
this mode.

ZOOM HORIZ Press ZOOM HORIZ and spin the Jog Wheel to zoom horizontally in the application, typically for the arrange or proj-
ect window time line. The yellow LED lights in this mode.

ZOOM VERT Press ZOOM VERT (SHIFT+ZOOM HORIZ) and spin the Jog Wheel to zoom vertically, typically to adjust the track 
height or waveform in the arrange or project window. The yellow LED lights in this mode.

Transport Controls

REW

Press REW to rewind. This function varies with the application. 

Implementations include: 

• Rewind until STOP or another key is pressed.

• Rewind a fixed amount.

• Rewind while the REW key is pressed until it is released.

FF

Press FF to fast forward. This function varies with the application. 

Implementations include: 

• Fast forward until STOP or another key is pressed.

• Fast forward a fixed amount.

• Fast forward while the FF key is pressed until it is released.

STOP

Press STOP to stop all other functions. 

PLAY

Press PLAY to play the project. 

REC

Press REC begin recording at the present location. All tracks armed for recording are punched into record. 
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CONTROL ROOM/MONITOR Knob
Turn the CONTROL ROOM knob to adjust the volume of the control room. The knob controls either Studio Monitor Express or an 
application that supports a EUCON monitor section. 

Press the CONTROL ROOM Knob Top key to mute the control room volume. Press it again to unmute.

Turn the MONITOR knob (SHIFT + CONTROL ROOM) to adjust the volume of Monitor A, commonly used as a headphone vol-
ume.

Press the MONITOR Knob Top key to mute the monitor volume. Press it again to unmute.
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Chapter 5: Touchscreen and Controls

Artist Control has a wide aspect ratio Touchscreen mounted in its center. 

The Touchscreen always shows the following:

1 Knob Displays Show the current knob function for their corresponding knob. There are four on each side of the Touchscreen. 

2 Info Area Shows the application and workstation name, the primary and secondary time code displays, or the attentioned track 
name. Touch this area to switch between them. 

3 Channel Strip Displays Shows the tracks assigned to the channel strips. The attentioned track is underlined in yellow.

4 Soft Key Labels Shows an optional icon followed by a text label for each of the 12 Soft Keys underneath the screen.

5 Menu Bar Displays the Tracks view, Soft Key view, Setup, or Surround screens on the Touchscreen. The center of the screen 
changes to reflect the selected Menu view.

2

1

3

4
5

1
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Tracks
Tracks view shows up to 32 tracks at a time to quickly mute, solo, arm, and select tracks that are not banked to the faders.

Select an operation on one of the four circular buttons on the left and then touch one or more of the square track buttons to perform 
that operation on the selected tracks. Touch a selected track button again to deselect it. 

SOLO A yellow circle surrounding an S on the lower left of the track rectangle shows the track is soloed.

REC A red circle around the track number in the lower right shows the track is armed to record.

MUTE A dark grey button shows the track is muted.

SEL The track’s rectangle is highlighted in yellow to show it is selected. The last track selected is attentioned.

The ̂  and v keys scroll down/up one row of eight tracks, if there are more lines of tracks in the project. Press the SHIFT key on Art-
ist Control or the workstation keyboard and touch one of these buttons to scroll up or down a full page (32 tracks). The track scroll 
arrow buttons are disabled if there are no further tracks to display. 

Track View
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Soft Keys

This view displays 24 Touchscreen Soft Keys in four lines of six each. 

v Scrolls forward to the next page of Soft Keys (unless on last page). 

^ Scrolls back to the previous page of Soft Keys (unless on page 1). 

Touch a Soft Key to execute its function. See Chapter 7, “Soft Keys” to learn how to customize Soft Key pages and create your own 
Soft Key functions.

Soft Key View
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Surround

The Surround view provides a 360 degree panner in which tracks can be panned by dragging their corresponding numbered dot. 

Track names and numbers are listed across the top of the view. In the center is the surround panner. To the left of the panner are 
two Soft Keys for Surround Panner Modes. 

The currently attentioned (selected) track is listed by name to the right of the surround panner. The circles with numbers within the 
panner identify the track or tracks that are available to view and pan, based on the current Surround Panner Mode. The circled num-
ber for the currently attentioned track has a yellow border; other tracks (when available) have no yellow border. 

The Attn button selects the Surround Panner Mode, and this button changes with each press (it cycles through the available modes, 
as explained below). When the current mode is Attn & Ctrl or Attn & Surf, the Multi Pan button becomes available and can be toggled 
on or off. When Multi Pan is enabled, you pan any tracks in the panner; when unlit, you can pan only the currently selected track. 

Attn Only, Attn & Ctrl, and Attn & Surf
The following modes affect which track objects are visible in the surround panner at one time:

Attn Only Displays only the selected track.

Attn & Ctrl Displays the currently selected (attentioned) track plus the four tracks banked to the Artist Control faders.

Attn & Surf Displays the currently selected (attentioned) track plus all tracks on all surface faders.

To select a Surround Panner Mode: 

 Tap the button until it displays the desired mode: 
• Press Attn Only to show the pan point of the track that has the surround panner’s attention (selected track). Multi Pan is not 

available in this mode. 
• Press Attn & Ctrl to show the pan point of the track that has the surround panner’s attention, as well as all the tracks that are 

currently banked to the Artist Control. 
• Press Attn & Surf to show the pan point of the track that has the surround panner’s attention, as well as all the tracks that are 

currently banked to appear on the whole surface. 
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Multi Pan 
In Multi Pan mode you can select different objects to pan in the surround panner screen. In standard mode you can only pan the se-
lected track. 

To toggle Multi Pan mode on or off: 

1 Make sure you are in either Attn & Ctrl or Attn & Surf mode (Multi Pan is not available in Attn Only mode). 

2 Press the Multi Pan button in the Surround view. When enabled, the button is lit; when disabled it is unlit. 

Using the Surround Panner (Example) 

To use the Surround Panner: 

1 Select a track. That tracks is listed by name to the right of the panner, and appears with a yellow circle around its track number 
at its current position within the panning field. 

2 Drag the track’s yellow circle within the stereo or surround field. On-screen the track pan controls change to reflect the current 
pan position. 

3 If the panner is in Attn Only mode, you can only pan the currently selected track. If Multi Pan mode is enabled, you can pan any 
track displayed in the panner by dragging its numbered circle. 

To pan other, non-selected tracks: 

1 Touch the Attn Only button until it displays Attn & Ctrl or Attn & Surf. 

2 If the Multi Pan button is unlit, touch it so that it becomes lit (enabled). 

3 Drag the numbered circle for any available track within the stereo or surround field. On-screen the track pan controls change to 
reflect the current pan position. 

Multiple tracks available for panning in Multi Pan mode
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Setup Screens
Less commonly used functions are found on the following Setup Touchscreens. The Soft Keys navigate through them. The Soft 
Key Exit Setup returns to the Touchscreen last used.

Control Room
The Control Room Touchscreen selects the source of the control room volume knob, and provides talkback, dim, and mute func-
tions. This is typically used to control Studio Monitor Express but can also control EUCON monitor sections if an application sup-
ports it.

Control Room Source Shows the possible sources to the control room volume control. The v and ^ arrow buttons scroll through 
sources if there are more than four. Touch to select the desired source, which is highlighted.

Talk Engages the talk function, which is typically used to talk to talent in a different room. The button lights up when talk is en-
gaged, even if engaged from the application or Studio Monitor Express graphic user interface (GUI). 

Dim Dims the control room volume (lit when dim is active).

Cut Mutes the control room volume (lit when cut is active).

Setup: Control Room
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Monitor
The Monitor Touchscreen selects the source of the monitor volume knob or mutes monitor A. Holding down SHIFT and turning the 
control room knob changes the volume of Monitor A in Studio Monitor Express or the attached application if it supports a EUCON 
monitor section.

Monitor Source Lists the possible sources to the monitor volume control. The up and down arrow buttons scroll through sources 
if there are more than four. Touching one of the sources highlights it and makes it the current monitor source.

Cut Mutes the monitor volume (lit when Cut is active).

Calibrating the Touchscreen
The Touchscreen is calibrated at the factory before shipping. You can recalibrate your Touchscreen at any time by doing the fol-
lowing. 

To recalibrate the Touchscreen: 

1 Start with the Artist Control powered off. 

2 Press and hold <BANK+BANK>+NUDGE> then press POWER to power on the unit. This puts the unit into Test mode. 

3 Touch the Touchscreen with your finger. This puts the unit into Touchscreen Calibration mode. A small box with a cross-hair ap-
pears on the Touchscreen. 

4 Press and hold directly on the cross-hair until it changes color, then release. After doing so, the cross-hair moves to a new loca-
tion. Repeat until complete. 

5 Power off the surface when you are done.

Setup: Monitor
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Chapter 6: EuControl

EuControl is launched automatically upon starting your computer and runs in the background. EuControl is responsible for finding, 
linking, and communicating with all Artist Series media controllers on the network. 

Accessing EuControl Settings

To open the EuControl Settings window, do one of the following: 

• On Mac, click the EuControl icon on the taskbar and select EuControl Settings.

• On Windows, click the EuControl icon in the Task or System tray (Windows) and select EuControl Settings. Unused icons are 
shown in the Hidden icons view. 

Only one instance of EuControl can run on a workstation. However, multiple workstations on a single network can each run 
EuControl. Each EuControl-equipped workstation can connect one Artist Transport, one Artist Control, and up to four Artist Mixes 
on the network. These multiple devices act together as a single control surface. Once connected, these Artist Series media control-
lers are not available to other instances of EuControl until relinquished.

The tabs in EuControl software are discussed in the order (left to right) as they appear at the top of the EuControl Settings dialog.

Surfaces
The Surfaces tab shows all Artist Series controllers on your network and those connected to your instance of EuControl. 

Artist Control Banks Independently

This option is only available when an Artist Control is selected in the My Surfaces list. When enabled, each Artist Series unit can 
bank independently of each other. In applications that support it, this lets you configure one unit for dedicated control of output bus-
ses, for example. 

Some EuControl features pertain only to Artist Mix and Artist Control, not to Artist Transport. These are noted at the 
beginning of each section.

Surfaces tab
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All Surfaces

All Surfaces shows all Artist media controllers on the network. A device shown in light gray is already connected either to your own 
or another instance of EuControl running on a different workstation. In both cases, it is not selectable. 

My Surfaces

My Surfaces shows the Artist media controllers connected to your instance of EuControl. There can be one Artist Control, one 
Artist Transport, and up to four Artist Mixes in the My Surfaces list, linked into a single large surface.

The top-to-bottom order corresponds to the left-to-right order of the surfaces, respectively. The left-most surface has fader 
number 1. Use the up and down buttons (to the right of the My Surfaces list) to reorder the list.

Each Artist Series controller can be renamed by double-clicking the existing name and typing a new name.

Add

Click Add to add the selected All Surfaces entry to My Surfaces. This connects this Artist Series controller to your instance of 
EuControl. You can also click and drag an Artist media controller from All Surfaces to My Surfaces.

Add is disabled if all Artist media controllers in All Surfaces are connected to any instance of EuControl.

Remove

Click Remove to remove the selected surface from My Surfaces and make it available to other instances of EuControl.

Remove is disabled if no surface is selected.

Automatically Add

The Automatically Add menu has two settings that control what happens to stored Surfaces between shutdown and startup.

All Surfaces (default) This setting is best used when you are the only person running EuControl in your home or studio. It provides 
an easy plug-and-play experience by automatically adding your All Surfaces list to your My Surfaces list so you never have to man-
ually edit the My Surfaces list.

My Surfaces Only  This setting is useful in facilities where other EuControl users are on your network. When EuControl starts, 
only the surfaces from your My Surfaces list are added. Because a surface can only be claimed by one user at a time, this avoids 
claiming another user’s surfaces.

Update Firmware

Each time a new version of EuControl is installed, each Artist Transport, Artist Control, and Artist Mix in your system may need 
its firmware updated. The firmware is embedded in EuControl so an Internet connection is not required. 

To update firmware: 

1 Select each Artist Series controller in the My Surfaces list (Shift-click to select multiple devices). 

2 Click Update Firmware to update their firmware. If a dialog displays a message that the firmware is up to date, no further action 
is necessary. 

3 Follow the instructions in the EuControl dialog box. While updating firmware, observe the following: 

• The Artist Series controllers must be plugged into a working power source.

• Do not power off any units during the update or attempt to interrupt the update.

• The status for each unit being updated is displayed on that device as well as in the EuControl dialog box.

Show Info

Select an Artist media controller and click Show Info to display the name, and hardware and software information on-screen. 
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Workstations
An Artist Series controller can control applications running on a second computer, referred to in this guide as a workstation. The 
Workstations tab establishes the list of workstations that the WORKSTATION key cycles through. Any workstation running 
EUCON software can be in this list, including those controlled by Artist Control.

All Workstations

All Workstations lists all EUCON-enabled workstations on the network. If the workstation is already in the My Workstations list, 
it is shown in gray and cannot be selected. 

My Workstations

My Workstations lists the workstations that can be attached to by pressing the WORKSTATION key. 

It is possible to put a workstation in the My Workstations list that is already attached to another instance of EuControl running on 
another computer. It cannot be attached here until it is unattached from the other instance of EuControl. This was done to allow 
multiple users to share workstations without having to frequently edit their My Workstation list.

Add 

Click Add to add the selected workstation from the All Workstations list to the My Workstations list. If the workstation is already 
in the My Workstations list, it is gray and cannot be selected.

Remove

Click Remove to remove the selected workstation from the My Workstations list. 

Attach/Detach

Select a workstation in the My Workstations list and click Attach. A check mark appears in the Attach column next to that work-
station. This workstation is now communicating with the Artist media controller(s) connected to your instance of EuControl. 

If the selected workstation is already attached, the button displays Detach.

Redirect Keyboard and Mouse Control to Attached External Workstation

Your computer keyboard and mouse can control a second external workstation, if desired. Select this option to redirect keyboard 
and mouse control to the attached workstation. Note that the keyboard and mouse will no longer control your primary workstation. 
If this option is not selected (default setting), your keyboard and mouse control your primary computer.

Workstations tab 
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You can manually toggle control back and forth between your primary workstation and the attached external workstation by press-
ing Control+Option+\ (Mac) or Control+Alt+\ (Windows). 

The Redirect Keyboard and Mouse Control to Attached External Workstation option must be checked before adding the workstation 
to the My Workstations list. If it is toggled ON after adding the workstation it will have no affect. Only workstations added with 
the option checked will respond.

General
The General tab controls how the Artist media controller and application software work together.

Workstation Tracks Knob Set Changes

Lets supported workstations follow selection of knob sets on the Artist Series unit. 

Open Plug-ins on Workstation When Editing

Lets supported workstations open plug-in windows on-screen when a plug-in is selected for editing on an Artist Series unit. 

Close Plug-ins on Workstation When Exiting

Lets supported workstations close plug-in windows on-screen when you press BACK or exit Inserts mode on an Artist Series unit. 

Select by Touch

Lets supported workstations attention (focus) tracks on-screen when their fader is touched on Artist Series units. 

Auto-bank to Selected Track

Lets Artist Series units bank to tracks when the tracks are selected on-screen. The surface will auto-bank such that the selected track 
appears on the left-most fader of the surface as long as the selected track is not currently visible on the surface. 

Display Track Numbers on Surface

Lets Artist Series units show track numbers as assigned by the current workstation (if supported). 

General tab
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Solo Mode

Lets you configure Artist Series units for the following Solo modes as (if) available in the current workstation: 

• Solo-in-Place

• After-Fader Listen (AFL)

• Pre-Fader Listen (PFL) 

See the documentation for your specific workstation for details on Solo modes. 

Wheel Sensitivity
The sensitivity of the Jog Wheel and Shuttle Ring can be precisely adjusted using the Wheel Sensitivity sliders. The top two sliders 
pertain to the Artist Transport, the bottom is the Jog Wheel for the Artist Control. 

The center position is the default for each control. Click and drag a slider to move it right for faster response or left for a slower, 
more controlled movement. Click the Reset button to restore the center position. 

The name of the currently focused application is shown above the sliders (the application that will be affected by adjusting Wheel 
Sensitivity). If the controls have been locked to a specific application, the display will list it and identify it as the application being 
adjusted. For more information on locking, see “Lock to Application” on page 41. 

Global or Application Specific

Click to enable the Global option to maintain a single set of your Wheel Sensitivity settings to be available regardless of the current 
application. 

Click to enable the Application Specific option to be able to have unique Wheel Sensitivity settings in each application you use. To 
store settings, switch to your other application, open EuControl Settings > General, and adjust the Wheel Sensitivity sliders for that 
environment. 

Preferences

Artist Mix, Artist Transport, and Artist Color Display Screen Dim Time
This slider only affects Artist Mix and Artist Transport. 

Artist Control Display
This slider adjusts the brightness of the Artist Control Touchscreen.

Preferences tab
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Footswitch
Artist Control lets you connect a footswitch for hands-free punch in and out. Connect a footswitch to the 1/4-inch FOOTSWITCH 
input on the back panel. 

To configure the Footswitch in EuControl: 

 In the Footswitch section of the Preferences tab, click to select the desired Punch In and Punch Out assignments: 

Record | Record  When the application is rolling, pressing the footswitch once punches into recording on record enabled tracks. 
Pressing the footswitch again takes the track(s) out of record but does not stop the transport. 

Record | Play Pressing the footswitch once punches into recording on record enabled tracks. Pressing the footswitch again stops the 
record pass (your DAW may or may not automatically take the track out of record on stop; see the documentation for your appli-
cation). 

Status Shows whether the footswitch state is currently on or off. 

Shift + Fader Sets Level to 0dB 
When enabled, holding SHIFT and touching a fader sets the fader to 0dB. SHIFT-lock does not apply (SHIFT must be pressed). 

Assign
The Assign tab manages how tracks are assigned to strips on the Artist Control or Artist Mix. By default, tracks are automatically 
assigned in banks of four. 

Display Application’s Track Numbers 
Enabling this checkbox lets EuControl display track numbers as assigned by the currently selected (in focus) application, if that ap-
plication supports track numbers. 

Clear All Assignments
Clears all currently displayed assignments. 

Assign tab
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Lock to Application
This feature lets the transport controls and/or the entire surface stay locked to the application listed at the top-left of the dialog, even 
when that application is not focused. The locked-to application also is the only application that will be affected by adjusting the Eu-
Control Wheel Sensitivity settings. 

Entire Surface Select this checkbox to lock the entire surface, including those of all linked Artist media controllers, to the listed ap-
plication. 

Transport Select this checkbox to lock the transport controls of Artist Transport and Artist Control to the listed application. All 
transport controls, including jog/shuttle wheels, are locked when selected. 

Monitor and Control Room Locks the Monitor and Control Room controls to the listed application. 

Layouts
Use the Layouts tab to store and recall assignments. For example, you can use the Assign tab to “lock” important tracks to specific 
faders, so they ignore banking. You can save that assignments as part of a Layout, so that you can easily switch between your “bank 
safed” layout and default banking, or other assignments. 

Soft Keys
The Soft Keys tab controls assignments and programming for all Artist Control keys (including the Jog Wheel, Shuttle Ring, and 
Numeric Pad), not just the six Soft Keys.

You can adjust the sensitivity of the wheels on both Artist Transport and Artist Control in the General tab. See “Wheel Sensitivity” on
page 39.

Layouts tab

See Chapter 7, “Soft Keys” for information on configuring the Soft Keys.
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Chapter 7: Soft Keys

This tab controls Surface and Touchscreen Soft Key assignments. The only difference between them is that the Surface Soft Keys 
are accessed by the 12 circular buttons below the Touchscreen, while the Touchscreen Soft Keys are accessed from the Soft Keys 
Setup Touchscreen (see “Soft Keys” on page 29).

The application listed in the upper left of the window is called focused because: 

• it is controlled by Artist Control

• it receives computer keystrokes and mouse events

Artist Control can control many applications, each with its own Soft Key assignments. Since Artist Control responds dynamically 
as the focused application changes, you may see the Soft Keys assignments change in EuControl. Switch the focus back to the de-
sired application and then switch back to EuControl to restore them. Although an application’s unsaved Soft Key edits are pre-
served between focus changes until you quit the application, it is recommended that you save your session or project frequently.

Be sure to check that the proper application is in focus before using Save, Restore, or Revert. 

Save
Click Save to permanently store any changes in assignment and/or function to the Soft Keys. Changes are retained even without 
clicking Save until you quit EuControl.

Revert
Click Revert to revert to the Soft Key assignments since the last Save command. This discards any changes made since EuControl 
was last started.

Soft Keys tab

For Pro Tools 10 and higher, see the Artist Series and Pro Tools guide to learn about the default Soft Key assignments for 
Pro Tools.
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Restore
Click Restore to restore the Soft Key assignments to the factory default settings.

Section
Click the Section popup menu to select the Soft Key type to edit: Touchscreen or Surface. The Touchscreen Soft Keys appear on 
the Artist Control’s Touchscreen and are executed by touch. The Surface Soft Key labels appear on the Touchscreen below the 
menu bar and are executed by pressing their corresponding circular keys below the Touchscreen.

Page
Select a Soft Key page to view and edit from the Page pop-up, or use the arrows beside the menu to increment/decrement the page 
by one. 

Plus Key (+)
Click the Plus key (+) to add a new page of Soft Keys after the last page. There is no limit on the number of Soft Key pages.

Minus Key (–)
Click the Minus key (–) to delete the currently displayed page of Soft Keys. 

Soft Key Label
Select a Soft Key (its outline highlights yellow) and type a label in this text field. 

Layout
Select Text Only, Icon Only, or Text and Icon from the Layout popup menu. 

Icon
Click the Icon button and select an icon from the dialog. 

Font
Click the Font button and select a font from the dialog. 

Color
Click the Color button and select a color from the dialog. 
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Command
Select a Soft Key (its outline highlights yellow) and click Command to view or edit the command(s) assigned to that Soft Key. 

The figure above shows a EUCON Key Command that sets a right locator marker. The type of command is set in the Details pane 
(left column). The center column shows the type of Key Command (Global Command). The specific Global Command is selected 
in the right column (Set Right Locator).

Key
Key commands can execute menu commands, other application-specific commands that have key equivalents, and even inject a 
specific text string if necessary. Key commands can also be used to make a macro, which consists of multiple commands executed 
sequentially by one Soft Key. 

Type keystrokes into the text field in the Details pane. Use the Control, Shift, Opt/Alt, and Command/Start modifiers along with 
the Insert Special menu to finish creating the key command. 

Select Repeat to repeat the command if the Soft Key is held down. For example, if the key executes a Nudge command and Repeat 
is selected, holding down the Soft Key will continue to Nudge. 

Command Editor

Key Command dialog
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Click Delete to delete the selected command.

EUCON
The EUCON command types under the Details column are specific to each application. Each application supports many EUCON 
commands. Browse them to determine the most useful commands for your projects. Consult the application’s documentation for 
specific questions about the commands. Non-EUCON-aware applications that do not support HUI or Mackie Control do not have 
EUCON commands. 

The width of the three right columns can be changed by clicking and dragging at the bottom of the scroll area.

Page
The Page command configures a Soft Key to jump to a specific Soft Key page. Select Touchscreen or Surface from the Section 
menu, and then select Next Page, Previous Page, or Jump to Page from the Action menu. The Page field, active only when Jump 
to Page is selected, specifies the Page number.

MC
The primary function of the MC command type is to recall a Layout (see “Layouts” on page 41). Select Recall Layout from the Ac-
tion menu and select the Layout number from the Layout menu. The other commands are for compatibility with MC Pro and are 
not used with Artist Control.

Jump to Page dialog configured to jump to page 1 of the Surface Soft Keys

Recall Layout command
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Create a New Soft Key
The Record command is created in the default application set for most, if not all, applications. This section shows how to create a 
new Soft Key using the Record command as an example. 

To create a new Soft Key:

1 Select Touchscreen or Surface from the Section pop-up menu.

2 Select a blank key and click Command.

3 Select Add > EUCON.

4 Select Transport Controls from the left column. EUCON commands automatically label the button but do not select an icon.

5 Select Record from the middle column. The completed Record command appears in the command list.

Jog Wheel Commands
The Jog Wheel can be assigned different commands than the typical jog and shuttle functions using additional Wheel 
Commands. It is important to note that there are two steps: 

• The desired Wheel Command must be selected and assigned to a Soft Key.
• That Soft Key must be pressed to invoke the function. 

The following examples demonstrate this process. These examples use Logic Pro so the dialogs for your application may look 
different. Be careful because these examples can overwrite a useful Soft Key if you click the Save button. When finished, click Re-
store to restore the Soft Key assignments to the state they were in before you edited them. If you did click Save, you can revert to 
the factory default assignments by clicking Revert.

Creating a command in the Soft Keys tab
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Custom Jog Command
Turning the Jog Wheel can insert key strokes into an application. This example inserts up and down arrows when the wheel is 
turned left and right, respectively. In most audio applications, this scrolls through the displayed tracks.

To create a custom Jog command:

1 Select Wheel from the Section pop-up menu. The Soft Key Wheel window opens. 

2 Double-click the Jog label. The Jog Wheel Command Editor opens.

3 Click the + button and select Arrow Keys as the name for the command. Note that the lower pop-up is set to Turn Jog Right. The 
Jog Wheel must be programmed to turn right and left.

It is normal for the window to show an image of the Artist Transport. 

Soft Key Wheel 
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4 Click the Add pop-up menu and select the Key command type.

5 Select Down Arrow from the Insert Special pop-up menu. You have assigned the command for the Jog Wheel to turn right, now 
assign it to turn left.

6 Select Turn Jog Left and select the Key command type from the Add pop-up menu.

7 Select Up Arrow from the Insert Special pop-up menu.

8 Close the Jog Wheel Command Editor. You can now select a Soft Key to press to assign it to the Jog Wheel.

To assign a Soft Key for the new Jog Wheel command:

1 In the Soft Key tab of EuControl, select Artist Control Surface from the Section pop-up. 

Jog Wheel command editor

Soft Keys dialog
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2 Find a blank Soft Key and double-click it. You may need to select a different (or new) page to find a blank key. The Soft Key 
Command Editor dialog opens.

3 Select the Wheel command type from the Add pop-up menu.

4 Select Artist Control’s Jog from the Wheel pop-up menu. Make sure to select Artist Control’s Jog (bottom) and not Artist Trans-
port’s Jog (top). Icons beside their labels make this clear.

5 Select Function > Custom > arrow keys. 

6 Close the Soft Key Command Editor.

7 Press the Jog Soft Key and spin the Jog Wheel to use the new Wheel command. To adjust Wheel Sensitivity, see “Wheel Sen-
sitivity” on page 39.

Soft Key Command Editor configured for Custom Wheel Command
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Assignable Knob
In some applications, the Jog Wheel can control knobs and sliders. Some applications require clicking on the control while others 
allow the cursor to hover over it. 

To assign the Jog Wheel to an Assignable Know:

1 In the Soft Key tab of EuControl Settings, select the Artist Control Surface from the Section pop-up. 

2 Find a blank Soft Key and double-click it. The Soft Key Command Editor opens.

3 Select the Artist Control Jog from the Wheel pop-up menu. Make sure to select Artist Control’s Jog (bottom) and not Artist 
Transport’s (top). Icons beside their labels make this clear.

4 Select Assignable Knob from the Function pop-up menu. 

5 Close the Soft Key Command Editor.

6 Press the Jog Soft Key to use the Assignable Knob function with the Jog Wheel. 

Soft Keys dialog

Soft Key Command Editor configured for Assignable Knob
Chapter 7: Soft Keys 51



Artist Control User Guide52



Chapter 8: Setting IP Addresses

In most types of installations you will never have to set a static Internet Protocol (IP) address, but in the rare cases that require it, 
use the instructions in this section. 

Normally, Artist Series media controllers use Dynamic Host Configuration Protocol (DHCP) to obtain IP addresses, typically from 
a router. Artist Control reverts to link-local addressing to generate an IP address if a DHCP server is not found on the network, such 
as when an Artist Control is connected directly to a computer with an Ethernet cable. Both of these methods of obtaining IP ad-
dresses can be overridden by supplying a static IP address, which Artist Control will then use in all cases when powered on.

To set a static IP address:

1 While holding down both <PAGE> keys simultaneously, press and release the POWER switch. The Network Setup screen ap-
pears on the Touchscreen.

2 Touch the parameter labeled Use DHCP (Obtain IP Address automatically). This deselects the parameter and displays the IP Ad-
dress and Subnet Mask fields on the Touchscreen.

Attempt this only if you have prior experience configuring a network.

Network Setup Touchscreen with Use DHCP selected
Chapter 8: Setting IP Addresses 53



3 Touch the first box of the IP Address field. Adjust its value by turning any of the eight knobs or the Jog Wheel. 

4 Use this technique to adjust all values of the IP Address and the Subnet Mask fields. Touch the Cancel button to cancel changes 
made to the IP address at any time.

5 Touch the OK button to save this static IP address. 

6 Power Artist Control off and on to use the new IP address.

Network Setup Touchscreen with IP Address and Subnet Mask fields
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Appendix A: Compliance Information

Environmental Compliance

Disposal of Waste Equipment by Users in the European Union

This symbol on the product or its packaging indicates that this product must not be disposed of with other waste. Instead, it is your responsibility to dispose of your waste 
equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste 
equipment at the time of disposal will help conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more 
information about where you can drop off your waste equipment for recycling, please contact your local city recycling office or the dealer from whom you purchased the 
product.

Proposition 65 Warning

Perchlorate Notice
This product may contain a lithium coin battery. The State of California requires the following disclosure statement: “Perchlorate Material – special handling may apply, See 
www.dtsc.ca.gov/hazardouswaste/perchlorate.”

Recycling Notice

This product contains chemicals, including 
lead, known to the State of California to 
cause cancer and birth defects or other re-
productive harm. Wash hands after handling.
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EMC (Electromagnetic Compliance)
Avid declares that this product complies with the following standards regulating emissions and immunity:
• FCC Part 15 Class A
• EN55022 Class A
• EN55024 Class A
• AS/NZS CISPR 22 Class A
• CISPR 22 Class A

FCC Compliance for United States

Australian Compliance

Canadian Compliance
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations. 

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le material brouilleur du Canada.

CE Compliance
(EMC and Safety)

Avid is authorized to apply the CE (Conformité Europénne) mark on this compliant equipment thereby declaring conformity to EMC Directive 2004/108/EC and Low Voltage 
Directive 2006/95/EC.

Korean EMC Compliance

(A ) 

, 
.

Communication Statement
Note: This equipment has been tested and found to comply with 
the limits for a Class A digital device, pursuant to part 15 of the 
FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference when the equipment is 
operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instruction manual, may cause 
harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the 
interference at his own expense.
Any modifications to the unit, unless expressly approved by Avid, 
could void the user's authority to operate the equipment.
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Safety Compliance

Safety Statement
This equipment has been tested to comply with USA and Canadian safety certification in accordance with the specifications of UL Standards: UL60950-1:2007, 2nd Ed and 
CAN/CSA C22.2 No. 60950-1-07, 2nd Ed. Avid Technology Inc., has been authorized to apply the appropriate NRTL mark on its compliant equipment.

Warning

Important Safety Instructions
1) Read these instructions.

2) Keep these instructions.

3) Heed all warnings.

4) Follow all instructions.

5) Do not use this equipment near water.

6) Clean only with dry cloth.

7) Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.

8) Do not install near any heat sources such as radiators, heat registers, stoves, or other equipment (including amplifiers) that produce heat.

9) Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two 
blades and a third grounding prong. The wide blade or the third prong are provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for 
replacement of the obsolete outlet.

10) Protect power cords from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit from the equipment.

11) Only use attachments/accessories specified by the manufacturer.

12) For products that are not rack-mountable: Use only with a cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the equipment. When a cart is 
used, use caution when moving the cart/equipment combination to avoid injury from tip-over.

13) Unplug this equipment during lightning storms or when unused for long periods of time. 

14) Refer all servicing to qualified service personnel. Servicing is required when the equipment has been damaged in any way, such as power-supply cord or plug is damaged, 
liquid has been spilled or objects have fallen into the equipment, the equipment has been exposed to rain or moisture, does not operate normally, or has been dropped.

15) For products that are a Mains powered device: 
The equipment shall not be exposed to dripping or splashing and no objects filled with liquids (such as vases) shall be placed on the equipment.

Warning! To reduce the risk of fire or electric shock, do not expose this equipment to rain or moisture. 

16) For products containing a lithium battery: 
CAUTION! Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type. 

17) For products with a power switch: 
It should remain accessible after installation.

18) The equipment shall be used at a maximum ambient temperature of 40° C.

19) This unit is provided with a power supply cord set suitable for 120V AC input only (for U.S.A.and Canada). For other than U.S.A. and Canada, a qualified person must 
provide for use with this unit, an appropriate, approved power supply cord set which is in compliance with the end use country requirements and has a minimum cross-sectional 
area of 1.0mm2.

20) For products with more than one power cord:
CAUTION: This unit has more than one power supply cord. Disconnect two power supply cords before servicing to avoid electrical shock.

ATTENTION: Cet appareil comporte plus d’un cordon d’alimentation. Afin de prévenir les chocs électriques, débrancher les deux cordons d’alimentation avant de faire le 
dépannage.

21) For products with an operator-accessible fuse:
CAUTION: For continued protection against risk of fire, replace only with same type and rating of fuse.

ATTENTION: Pour ne pas compromettre la protection contre les risques d’incendie, remplacer par un fusible de même type et de même caractéristiques nominales.
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Avid
2001 Junipero Serra Boulevard 
Daly City, CA 94014-3886 USA
Technical Support (USA)
Visit the Online Support Center at 
www.avid.com/support
Product Information
For company and product information, 
visit us on the web at www.avid.com


	Contents
	Chapter 1: Introduction
	What’s Included
	System Requirements and Compatibility
	Registration
	About This Guide
	About www.avid.com

	Chapter 2: Installation and Setup
	Unpacking and Elevating the Artist Control
	Attaching an Artist Control to Additional Units
	Installing Software and Hardware

	Chapter 3: Common Tasks
	Fader Strip
	Inserts
	Transport Keys and Jog Wheel

	Chapter 4: Surface Controls
	Power Switch
	Shift Key
	Fader Strips
	Navigation Controls
	Knobs
	Soft Keys
	Jog Wheel and Transport Controls
	CONTROL ROOM/MONITOR Knob

	Chapter 5: Touchscreen and Controls
	Tracks
	Soft Keys
	Surround
	Setup Screens
	Calibrating the Touchscreen

	Chapter 6: EuControl
	Surfaces
	Workstations
	General
	Preferences
	Assign
	Layouts
	Soft Keys

	Chapter 7: Soft Keys
	Save
	Revert
	Restore
	Section
	Page
	Plus Key (+)
	Minus Key (–)
	Soft Key Label
	Layout
	Icon
	Font
	Color
	Command
	Jog Wheel Commands

	Chapter 8: Setting IP Addresses
	Appendix A: Compliance Information
	Environmental Compliance
	EMC (Electromagnetic Compliance)
	Safety Compliance


